
a web-based venue for live performance

User Manual for UpStage V2
Updated July 2007

              



Contents

1 Introduction.............................................................................................................. 1
1.1 Background...................................................................................................... 1
1.2 Project Team ................................................................................................... 2
1.3 Glossary .......................................................................................................... 3

2 Audience ................................................................................................................. 4
2.1 Getting to the stage.......................................................................................... 4
2.2 Audience Chat ................................................................................................. 4

3 Players .................................................................................................................... 5
3.1 Logging in ........................................................................................................ 5
3.2 The Workshop: administration interface............................................................ 6

3.2.1 Creating and Managing Players................................................................ 7
3.2.2 Creating and Managing Stages................................................................. 7
3.2.3 Uploading and Managing Avatars ............................................................. 9
3.2.4 Uploading and Managing Props.............................................................. 10
3.2.5 Uploading and Managing Backdrops....................................................... 11

3.3 On Stage ....................................................................................................... 11
3.4 Holding and Moving an Avatar........................................................................ 12

3.4.1 Tools ...................................................................................................... 13
3.4.2 Operating Multi-frame or Animated Avatars............................................. 14
3.4.3 Changing Your Avatar’s Name................................................................ 14
3.4.4 Avatar Layers ......................................................................................... 14

3.5 Holding and Placing Props ............................................................................. 14
3.6 Changing Backdrops ...................................................................................... 15
Speech and Text Chat ............................................................................................... 15

3.7.1 Saving the log ........................................................................................ 16
3.8 Whispering..................................................................................................... 16
3.9 / Commands .................................................................................................. 17
3.10 Drawing ......................................................................................................... 17
3.11 Audio ............................................................................................................. 19

4 Graphics Recommendations .................................................................................. 20
4.1 General comments......................................................................................... 20
4.2 Creating .pngs................................................................................................ 20
4.3 Creating .swfs ................................................................................................ 20
4.4 Animated Avatars and Props .......................................................................... 21
4.5 Backdrops...................................................................................................... 22
4.6 File Sizes ....................................................................................................... 23
4.7 Deleting Graphics........................................................................................... 24
4.8 On-stage Links............................................................................................... 24

5 Technical ............................................................................................................... 25
5.1 Client Hardware & Software Requirements..................................................... 25

5.1.1 Hardware ............................................................................................... 25
5.1.2 Software................................................................................................. 25

5.2 Firewalls ........................................................................................................ 26
5.3 Downloading and Installing the Server Software ............................................. 26

5.3.1 Customising UpStage............................................................................. 26
5.4 Web cams...................................................................................................... 27

5.4.1 Recommended Web Cam FTP Software ................................................ 27
5.4.2 Recommended Software for Windows Operating Systems...................... 27
5.4.3 Recommended Software for Macintosh................................................... 28



5.4.4 Recommended Software for Linux .......................................................... 28
5.4.5 Web Cam FTP Configuration .................................................................. 28

5.5 Speech .......................................................................................................... 29
5.6 Troubleshooting ............................................................................................. 31

5.6.1 Browser Problems .................................................................................. 31
5.6.2 Stage Won’t Load................................................................................... 31
5.6.3 Fonts look bad........................................................................................ 31
5.6.4 Linux Fonts ............................................................................................ 32
5.6.5 Other problems....................................................................................... 32

UpStage is free and open source software and it is constantly in development, as is this
manual. Contributions to the manual and the software are welcome – please email
info@upstage.org.nz.

Version Control:
June 28 2007 UpStage Version 2 User Manual
July 22 2007 V2 manual updateed to include information about layering avatars,

on-stage links and audio.



UpStage V2 User Manual, updated July 2007 1 of 35

1 Introduction

1.1 Background
UpStage is a web-based venue for the real-time compilation of digital media into live
performance, by multiple remote players for an online audience. People anywhere in the
world can participate in live performance events by using standard browser software to
access UpStage, without having to download and install additional software and without
needing to know anything other than a web address.

The concept for UpStage was developed by Avatar Body Collision1, a globally dispersed
cyberformance2 troupe whose members have been experimenting with online theatrical
performance since 1999. UpStage was born from the desire to reach a wider audience and
to make it easier for audiences and performers alike to participate in live performance via
the internet.

The software combines the different elements of cyberformance - graphical avatars, web
cams, audio, images, text chat (and who knows what else in the future) - into a single
interface. The audience simply direct their browser to the web address at the appointed
time, to watch and participate in the cyberformance.

UpStage is open source and free to download. It is available under dual licensing: a
Creative Commons Attribution-NonCommercial-ShareAlike 2.5 License
and GNU General Public Licence (GPL).

The initial development of UpStage was funded in 2003 through the Smash Palace
Collaboration Fund, a joint initiative of Creative New Zealand and the NZ Ministry of
Science, Research and Technology. In 2006, the UpStage project received funding from
the Community Partnerships Fund of the New Zealand government’s Digital Strategy to
develop UpStage version 2. UpStage V2 has also been supported by partners CityLink,
MediaLab and Auckland University of Technology.

This manual provides general instructions for the use of UpStage; it is divided into five
sections:

o Introduction;
o Audience;
o Player;
o Graphics; and
o Technical (including server installation).

For further information and updates, please visit www.upstage.org.nz.

                                                  
1 www.avatarbodycollision.org
2 Cyberformance uses internet technologies to bring remote performers together in live theatrical events;
www.cyberformance.org.



UpStage V2 User Manual, updated July 2007 2 of 35

1.2 Project Team
The UpStage project was initiated and driven by Avatar Body Collision, who are Vicki
Smith, Leena Saarinen, Karla Ptacek and Helen Varley Jamieson. For more information
about the Colliders, please visit www.avatarbodycollision.org.

The programme was written by Douglas Bagnall, who has a background in open source
development of online projects, and is also a digital artist. His artistic work includes the
development of a film-making robot and a cloud-classifier; visit http://halo.gen.nz.

Since December 2004, the UpStage server has been generously hosted by Citylink,
www.citylink.co.nz/ and MediaLab has provided project management support and
resources for the project (www.medialab.co.nz).

Thanks to Anne Philpott, we have established a relationship with Auckland University of
Technology (www.aut.ac.nz/). which has seen final year software development students
working on UpStage as their major project. In 2006, Beau Hardy, Francis Palmer, Lucy
Chu and Wise Wang contributed considerable enhancements to the software – thank you!
And at the time of writing, the 2007 team of Endre Bernhardt, Lauren Kilduff, & Philip
Quinlan have just begun work.

Many other people have contributed to the development of UpStage through
encouragement, advice, testing, feedback, and simply believing that it was possible. The
project team thanks every one of you.

If you are interested in being a part of the development of UpStage, you can join the
developer list, https://lists.sourceforge.net/lists/listinfo/upstage-list.

If you would like to be kept informed about events in UpStage, you can join the
announcements list: https://lists.sourceforge.net/lists/listinfo/upstage-announce.
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1.3 Glossary
Here are definitions for some terms that are used in this manual.

Audience: people present online at a performance, but not logged in. The audience can
participate via the text chat, but do not have access to the same tools as the players.

Avatar: a graphical icon that can be held and moved around the stage by a player, and
that can speak.

Backdrop: a graphic which fills the stage behind any avatars and props that are placed
on it. A backdrop can also extend behind the text chat.

Chatters: the online audience are often referred to as “chatters”, as they contribute to the
performance via a text chat function.

Mirror: the square on a stage that shows a Player which avatar they are currently
holding.

Player: a logged-in participant in a performance. Players have access to on-stage tools
which allow them to manipulate avatars, backdrops and props.

Prop: a graphic which can be held by an avatar or placed on the stage.

Stage: a dynamic web page where you can place and move avatars, props and backdrops
to create a performance.

Text chat: an input field and text chat window, where avatars’ speech and audience text
appears and is visible to everyone; the text chat window can be scrolled up and down to
read text that has been entered previously.

Tools: the buttons, sliders and icons that allow logged-in players to manipulate media.

Wardrobe: the interface through which players can select avatars on a stage; an
alphabeticised and scrollable list of the icons and names of the avatars assigned to that
particular stage.

Whispering: silent text communication between logged-in players that is not visible to
the audience.

Workshop: the “back stage” interface where logged-in Players can upload graphics,
view existing graphics, create and manage stages and manage players.
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2 Audience

Audience members enter UpStage by following a web link from an email or another web
page, and participate in the performance via the text chat. Audience members do not log
in, and therefore do not have access to the same on-stage tools as Players do.

2.1 Getting to the stage
Audience members can arrive at a stage a number of ways: they may have clicked on a
direct link to the stage in an email, or on a web page. Or they may have come to the
UpStage foyer and selected the stage from a list of available stages.

A splash screen covers the stage while it loads, preventing the audience from interacting
until the stage is fully loaded. Once the stage has loaded, the audience will see any
graphics that have already been placed on the stage, they will see and hear the
performance, and they will be able to participate in the text chat.

2.2 Audience Chat
Audience members are also known as “chatters”, because they can interact with the
performance by typing into the text input field at the bottom right of the screen. This text
appears in the text chat window, amongst the Players’ text. Player text is slightly darker
and larger than audience text, and identified with the avatar’s name. Audience text is
grey, silent and anonymous.
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3 Players

Players log in to UpStage to create and present performances. Once logged in, they have
access to the Workshop area where they can upload images, and to a set of on-stage tools
that enable them to manipulate media for a performance.

3.1 Logging in
Once a player has been given a username and password, they can log in to UpStage from
the foyer. The foyer is the default home page for an UpStage server; it is an HTML page
and can therefore be easily customised with your own information and direct links to
stages for the audience.
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3.2 The Workshop: administration interface
Once you have logged in to UpStage, you arrive at the Workshop, from where you can
either proceed directly to the Stages to rehearse or perform, or choose from a range of
administrative options. These options allow you to upload and manage Stages, Players,
Avatars, Props and Backdrops.

The Workshop screen is an HTML page and can therefore be updated to include direct
links to the stages you are currently working on and notices for other players using this
UpStage server.
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3.2.1 Creating and Managing Players
This is where you can set up the log-in and permissions for a new player, or change those
for an existing player.

Add a new player
Create a log-in for a new player, and set
their permissions – i.e. whether they have
access to the Workshop or just to the
Stages, and whether they can add and
delete players.

Manage players
Here you can:

 change a player’s log-in, name and
permissions;

 delete players (if you have the
rights to do so).

From the Workshop, click on the link
“Manage Players” and select the Player
you wish to manage from the list of
Players.

3.2.2 Creating and Managing Stages

Set up a new Stage
To create a new stage, click on the link “Set up a new stage” and give your stage a name.
This name will appear in the list of existing stages. It won’t be accessible to audience
members until you make it public in some way (for example, create a link to it from the
Foyer, or email the URL to your target audience), but it will be visible to logged-in
players and can be accessed for rehearsals or closed performances.

The URL for a stage is http://yourserverURL/stages/stagename. You can create a link
directly to a stage from the Foyer or from another web site by editing the HTML just as
you would create a link to a web page.

Manage Stages:
This is where you can:

 assign and unassign avatars, props and backdrops for an existing stage;
 edit the splash screen message for a stage;
 rename the stage;
 reset the stage;
 delete old stages.
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From the Workshop, click on the link “Manage an existing stage”; you will see a list of
stages, and if any players or audience are on a stage it will be shown here. Select the
stage you wish to manage from the list of stages by clicking on its name.

The Stage edit screen shows a list of all the available avatars, props and backdrops. You
can also edit the splash screen message that will appear while the stage is loading. This is
a good place to put information about your show such as the title and who it’s by.

Use the check boxes to select images for the stage, then click the “save changes” button
at the top or bottom of the screen. The screen will refresh, telling you that the stage has
been updated and showing the items that you have selected as checked. Once you have
assigned avatars, backdrops and props to a stage, they will appear in the  Wardrobe and
Image Gallery of that stage (see Section 3.3).
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At the bottom of the “Manage an existing stage” screen you can reset the stage. This
clears all the text from the text chat window and returns the stage to its default state. If
you need to reset the stage during a rehearsal for some reason, everyone should leave the
stage and reload it in a couple of minutes (otherwise it will throw them off and
automatically reload).

Currently UpStage can’t create a thumbnail from a .swf file, so you will notice that
images uploaded as .swfs have a question mark graphic as a placeholder. To see one of
these images, click on its name to go to the edit screen.

Note that if you wish your avatars to appear in a particular order front to back on stage
(i.e. layering) then you need to assign them to the stage one by one, saving the stage
between each avatar. The first one will appear furtherest back and the last one at the
front.

3.2.3 Uploading and Managing Avatars
In the Avatar section of the Workshop, you can upload new avatar images and video
streams, delete unwanted avatars, listen to available voices and change an avatar’s voice.

Uploading a new avatar
Avatars can be still images in .jpg, .png or .swf format, multi-frame avatars, animated
.swf files, or motion jpegs from a web cam. A single avatar can be composed of all .png
files, or all .jpg files, or a single (possibly animated) .swf file. Multi-frame avatars can
have a maximum of 10 frames (images), all of which must be the same format (either
.png or .jpg). There are a number of tricks that will help to achieve the best avatars - see
Section 4 for how to create graphics for UpStage.

Once you have created your avatar in a graphics application, click on “Add a new avatar”
in the Workshop; give it a name (every avatar must have a unique name) and browse to
the file(s) on your hard drive. Click ok and the file(s) will be uploaded to UpStage, and
you will see the avatar’s edit screen. This is where you can select a voice for your avatar.

If you are creating a new web cam avatar, you will first need to set up your web cam with
FTP access to your UpStage server; see Section 5.4 for details and recommended
software. Once your image or video stream is ready, follow the link from the Workshop
to “Add a new avatar” and find your filename in the drop down list of available video
streams. Choose a name for the avatar then click OK.

Go back to the Workshop and follow the link to “Manage Avatars” and you will see the
name of your avatar in this list. It will also appear in the list of avatars when you are in
the "Manage Stages" section, allowing you to assign it to a particular stage.
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Manage Avatars
This screen shows the list of available avatars; you can change the avatar name and the
voice it will speak with, and delete unwanted avatars. It also shows you which stages
each avatar is currently assigned to.

Click on the name of the avatar you want to edit. You will see a thumbnail image of the
avatar and information about the file, and you can choose from the drop down list of
available voices and test voices to see what they sound like.

3.2.4 Uploading and Managing Props
Props function in a similar way to avatars, but they can’t speak, and you must be holding
an avatar in order to use a prop. When an avatar is holding a prop, it appears on stage at
the top left corner of the avatar. If another player clicks on the same prop, it will appear
to be passed to the other player’s avatar. Invisible avatars are useful for placing props on
the stage.

Uploading a new prop
Props are created in the same way as avatars, and should be still images in .png or .swf
format; see Section 4 for recommendations about creating graphics for UpStage.

From the Workshop, follow the link to “Add a new prop”, and navigate to the appropriate
file on your hard drive. Choose a name for it and click OK to upload.
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Manage Props
This screen shows a list of available props; you can change the prop name, and delete
unwanted props.

3.2.5 Uploading and Managing Backdrops

Uploading a new backdrop
Backdrops can be still images in .jpg, .gif, .png or .swf format. See Section 4.5 for
recommendations about creating backdrops for UpStage. From the “Add a new
backdrop” link in the Workshop, navigate to the appropriate file hard drive. Name it and
click OK to upload.

Manage backdrops
This screen shows a list of available backdrops; you can change the backdrop name,
delete unwanted backdrops, and see which stages a backdrop has been assigned to.

3.3 On Stage
The stages look slightly different for players and audience (chatters). The audience see
the stage area and the text chat window (see the screengrab in Section 2), different
backdrops as the players change them, and the props and avatars that the playersmove
around the stage. They will also see and hear the avatars' speech, and can input text into
the chat window; in the future we hope to have other interactive functios for the audience.
What the audience don’t see but the players do, is the stage tools.
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The Wardrobe (top right hand corner) is a scrollable list of the avatars assigned to this
stage. The Mirror (the square beside the Wardrobe) shows the avatar you are holding,
with its name in the rectangle under the mirror. There tools below the Mirror and image
galleries for backdrops and props along the bottom of the stage area. Players see a smaller
text chat window.

3.4 Holding and Moving an Avatar
The avatars assigned to a stage appear as small icons in the Wardrobe. To hold a
particular avatar, click on its icon in the Wardrobe (use the arrows to scroll up and down
the Wardrobe). The icon will disappear from your Wardrobe and appear in your Mirror,
the square area to the left of the Wardrobe. This shows you which avatar you are
currently holding. A greyed-out icon in your Wardrobe means that another player is
holding that avatar.

Once you have an avatar in your Mirror, click on the stage area and your full-size avatar
will appear there. Click in another place, and it will move there.
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3.4.1 Tools
The Player tools are the set of buttons below the mirror.

Fast/Slow
This button controls the avatar
movement – fast causing the
avatar to jump to where you
click, and slow causing it to glide
there. The button shows the
action that the avatar will change
to when next clicked – for
example if your avatar is gliding,
the button will show fast. Click
on it to change to fast, and the
button will become orange and
say “slow”.

Stop
When your avatar is gliding (in slow mode), click on stop to stop it at any point in its
trajectory.

Drop
The drop button will remove your avatar from the stage, and put it back in the Wardrobe
so that you are no longer holding it. If you want to leave your avatar on the stage while
you operate another avatar, select the new avatar from the Wardrobe without first
clicking on drop.

Clear
Use clear to remove all unheld avatars and props from the stage.

Name
This button will hide or show your avatar’s name when it is on the stage - particularly
useful when working with invisible avatars. When you first hold an avatar, the default
state is for the name to be showing, so click on “name” before you place the avatar on the
stage if you don’t want the name to show.

Draw/Act
This button changes the function from acting to drawing and back again. See Section 3.10
for more information about how to draw.

Player/Audience counter
Below the control buttons, a counter keeps a live tally of the number of players (P) and
audience (A) present on stage at any time. Typing /details will list the usernames of the
players and the number of audience in the chat window.



UpStage V2 User Manual, updated July 2007 14 of 35

3.4.2 Operating Multi-frame or Animated Avatars
Avatars that have been created as .swf animations, or uploaded as multiframe avatars,
allow you to change the avatar while it is on stage.

Animated Avatars
Created as .swf files, these avatars will animate in the Workshop, Wardrobe and Mirror.
When placed on stage, animated squences will appear as a still image in the first frame of
the animation. Type /a 0 to start the looped animation, and to display a different still
frame type /a 1 (the default), /a 2, /a 3 etc.

Flash Movieclips will animate on loop without typed-in commands. You need to create
these as movies in Flash – see Section 4.4 for more information.

Multi-frame Avatars
These work in a similar way to the animated avatars, but are created by uploading a series
of still images (in .png or .jpg format) rather than using Flash.

3.4.3 Changing Your Avatar’s Name
To change the name of the avatar you are holding, type /nick newname in the text input
field. You will see the name underneath your mirror change, and when the avatar is on
stage the new name will appear below it (unless you have used the “name” button to turn
off the name). When using invisible avatars, you can make words float around the stage.

3.4.4 Avatar Layers
The layering of avatars (which ones appear in front of or behind others) is determined by
the order in which each avatar is assigned to a stage. To control which avatars are in front
or behind others, assigned them to a stage one by one, saving the stage each time. The
first avatar assigned to the stage will be the furtherest back, and the last will be the closest
to the front. If the order of layering does not matter, you can assign your avatars as a
group.

It may be possible to develop a better way to control this is future, including being able to
change the layer order on stage.

3.5 Holding and Placing Props
The props available to you in a particular stage appear as small icons in the Props Gallery
at the centre bottom of the screen. When you roll your cursor over the icons, a name label
appears, allowing you to distinguish between similar or very small props.

You must be holding an avatar and be on stage to hold a prop. Click on the prop icon in
the Gallery, and it will appear at the top left of your avatar. Click again on the prop icon
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in the Gallery, and it will remove the prop from your avatar. If another player clicks on
the same prop that you are holding, it will be transferred to their avatar.

3.6 Changing Backdrops
The backdrops assigned to a particular stage appear as small icons in the Backdrops
Gallery, at the bottom left of your screen. Roll your cursor over the icons to display the
name label so that you can accurately choose the backdrop you want.

Click once on the icon to place the backdrop onto the stage; click the icon a second time
to remove it.

3.7 Speech and Text Chat
To make your avatar speak, type into the text input field
below the Chat window (bottom right of your screen) and
hit enter (if there isn’t a blinking cursor line there already,
you may need to click the mouse there).

Your text will appear with your avatar’s name in the text
chat window, as well as on the stage beside your avatar
(unless you have not put your avatar onto the stage). It will
also be spoken in the voice selected for that avatar.

The audience can also type
into the text chat, but their text
won't be spoken out loud and
only appears in the text chat
window, not on the stage. As
the audience don’t log in, there are no names connected to
the audience chat. If you aren’t holding an avatar, your text
will appear as audience text.

You can also make your avatar “think” by typing : (a colon)
before the text. Your text appear in a thought bubble over
the avatar, but not be spoken aloud. It will appear in the text
chat window in blue and with curly brackets around it.

Note: it is possible to play prerecorded audio loops, but only by creating an avatar that
uses actionscript in a .swf file to stop and start the audio (otherwise it will loop
continuously).
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3.7.1 Saving the log
The text chat is automatically saved by the server, and can be viewed by adding “/log” to
the end of the URL in the address bar of your browser while you are on the stage. You
can then save it by either selecting “Save as” from your browser’s file menu, or by
copying and pasting the text into another application.

3.8 Whispering
Players can “whisper” to other logged in players; this lets you communicate with your
fellow players without the audience hearing or seeing. You can whisper to an individual
player, a number of players, or to all logged in players present on the stage.

Typing in a whisper command incorrectly displays a “how to” message in your chat
field.  If messages are not delivered to users (due to misspelling a username, or a user not
currently being online), the whisper "bounces" and informs the sender what went wrong
in the chat field.

Commands:
To whisper to a single player, type:
/wh username1=Message

To whisper to multiple players, type:
/wh username1, username2, ...=Message

To whisper to all users on the current stage, type:
/wh *=Message

Note - /whisper works exactly the same as /wh
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3.9 / Commands
When you are on stage, there are a number of commands you can type into the text field
to do certain things:

/a 1, /a 2 etc diisplays a different frame of an animated or multiframe avatar
/a 0 animates a multiframe or animated avatar
/asize /asize followed by a number will adjust the size of the audience text

in your chat window (note – this only affects your own screen; the
text size will not adjust for the audience or other players); the
default size is 4

/details lists the usernames of all players and the number of audience
members who are present on that particular stage.

/help gives you a list of some of these commands
/info shows information about UpStage including which version of the

software you are using
/nick allows you to change the name of the avatar you are holding – type

/nick newname
/license provides information about the dual GPL and Creative Commons

license
/psize /psize followed by a number will adjust the size of the player text in

your chat window  (note – this only affects your own screen, the
text size will not adjust for the audience or other players); the
default size is 4

/whisper or /wh allows you to communicate with other players without the audience
being aware; the whisper command is explained in Section 1.5

3.10  Drawing
Clicking on the “draw” button in the control panel reveals a different set of player tools –
the Drawing Palette. You can be still holding an avatar while you are drawing and can
speak, but you won’t be able to move your avatar. Clicking on the “act” button will return
the Wardobe, Mirror and Controls so that you can operate your avatar.

Drawing allows you to draw directly onto the stage, in one of four layers. The top box
will draw on the top layer, obscuring avatars. The next two layers will let you draw
amongst the avatars, and the bottom layer draws behind the backdrop.

Tools for each of the four layers are in the boxes on the right – click on the pencil to
select that layer and draw. The black border shows which layer you have selected; a pale
blue border indicates that another player is holding that layer. If you select a layer with a
blue border you will “steal” it from the other player.
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Click on the eye to hide or
show your drawing. Click on
clear to erase the all the
drawing from that layer.

The slider in the layer box
controls transparency: move it
to the left and the drawing in
that layer will become more
transparent; move it all the way
to the left and it will vanish
completely.

The colour picker at the top has
three sliders, letting you adjust

the colour of what you’re about to draw. Move the sliders to change the hue, and the new
colour appears in the square to the left of the sliders.

The slider immediately below the colour picker controls the transparency of what you are
about to draw (use the slider in the layer box to change the transparency of something
you’ve already drawn).

The circle and slider below the
transparency slider control the size
of your pencil. Move the slider to
the right and the circle will
increase in size, indicating how big
it will appear on stage. Move it to
the left to make it smaller.

Currently it is not possible to erase,
other than to clear everything in a
particular layer. If you are trying to
draw a curved line and finding that
it appears as sections of straight
lines, you are moving your mouse
faster than UpStage can keep up
with; try drawing slower for
smoother curves.
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3.11  Audio

UpStage V2 has not addressed the addition of audio tools – this is a feature request for
the future. However, it is possible to create Flash avatars that contain audio and can be
manipulated on stage. The two ways that have so far been experimented with are using
ActionScript to create a button that allows control of the sound, and embedding a sound
in a specific frame of an animated avatar. Both methods have disadvantages – with the
first method it is necessary for each audience member to click on the button at the
required time in order to hear the sound; with the second method, it is controlled by the
player(s), but the audience will hear the sound once when the stage loads.
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4 Graphics Recommendations

4.1 General comments
Avatars, backdrops and props for UpStage can be created using standard graphics
applications such as PhotoShop, Fireworks, Gimp and Flash. The recommended formats
for original graphics files are .swf or .png. Vector-based images will appear much cleaner
than pixel images (such as .gif and .jpeg), as they are resized to match the dimensions of
individual screens and browsers. You can use .gif and .jpg but your images will lose
quality.

Avatars and props will appear on stage approximately two to three times larger than the
original file. This is because the stage is not in a fixed size window: it allows for different
screen resolutions and sizes, and different sizes of browser window. The aspect ratio is
7:3 (see the backdrop diagram in section 4.5).

The recommended size for the original file for a “standard” sized avatar is approximately
100x100 pixels – obviously you will want bigger and smaller ones but this gives you
somewhere to start. In order to test the size of a graphic, you must upload it, assign it to a
stage, then look at it on that stage (the same applies to props).

It can be a time-consuming process getting your graphics to the size you want, so it’s a
good idea to make a couple of samples first and then base the rest of your graphics on
those once you have got them the size you want (this applies to both props and avatars).

4.2 Creating .pngs
The .png file format is recommended for avatars and props, rather than .gif or .jpg, as it
allows for transparency and gives a good quality image. Files can be saved in .png format
in most graphics applications. In the File menu, choose "Save As" and look for the .png
option. Do NOT interlace the file when you save it.

4.3 Creating .swfs
Although UpStage itself is open source and we've done everything we can to make it
cross-everything, it is accessed via the Flash Player plug-in and so far it seems that the
most successful graphics format is .swf. To create .swf files, you need the Flash
application. (An open source equivalent plug-in, Gnash, has recently become available,
but we have yet to fully test it with UpStage and it is a media player browser plug-in, not
a graphics application).

Please note that the following information is by no means a comprehensive Flash
tutorial. If you do not know how to use Flash at all, or if the following steps are not clear
to you, we recommend that you look on the web for a Flash tutorial.
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The basic steps for producing a single frame avatar or prop using Flash is as follows:

• Start with a .png file in which you have clear-cut your image and given it a
transparent background. Keep the .png image at maximum size.

• Open Flash and from the File menu, choose Import, navigate to your .png file and
import it into Flash.

• Click on the image to select it – a border appears around it.
• In the Insert menu, choose "Convert to symbol" – the border will change to a thin

blue line.
• Then resize it (Modify > Transform), remembering that avatars and props will

increase in size by about 2-3 times when uploaded into UpStage. Around 100
pixels is a good size to begin with if you don’t know what size you want.

• Once you have reduced it to the requred size, adjust the document size to match.
• From the File menu, choose Export Image. Uncheck the compress movie option,

and put the jpeg quality up to 100%.

4.4 Animated Avatars and Props
UpStage supports both animated sequences and Flash movie clips. When you put
sequenced (frame-by-frame, or motion or shape tweened) animation onto the stage it will
appear static with the image in the first frame (/a 1). To change to other frames of the
animation, type /a 2, /a 3, etc. To make the avatar animate, type /a 0.

Movie clip animation does not need any commands, it will automatically loop and can be
used on stage either as a continuosly looping animation or as a series of still avatars that
are swapped using the /a command, as above.

Props and backdrops can also be animated using Flash. But bear in mind that Flash
animations can end up as larger files, which will increase the time it takes to load your
stage.

To create an animated sequence, follow these steps:

• First create a series of .png files (as above) and give them numbered filenames.
• Open Flash and from the File menu, choose Import and navigate to the first .png

file; Flash will ask if you want to import the series, say yes. This will create a
frame for each image.

• Going to each frame in turn, click on the image to select it (a border appears
around it), in the Insert menu, choose "Convert to symbol" (the border will
change to a thin blue line) then resize (Modify > Transform), remembering that
avatars and props will increase in size by about 2-3 times when uploaded into
UpStage.
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• Once the images are all reduced to the requred size, adjust the document size to
match; if your images are not all exactly the same size make sure you have made
the document size as big as the largest image.

• From the first frame, and with the image selected (the blue line should appear
around it), go to the Insert menu and select “Create motion tween”.

• To check that the tweening has happened, go to the Control menu and hit play –
your sequence of images should play.

• From the File menu, choose Export Movie. Uncheck the compress movie option.
Put the jpeg quality up to 100%.

Sounds can be embedded into Flash movie clips, but currently there is no way to start or
stop them, so the sound will be heard all the time - even when the graphic is not visible
on stage. An audio feature is in development during the second half of 2007.

When using Flash to create animated avatars and props, be sure to check the the frame
rate and whether it is set up to loop.  If the frame rate is, for example, 24 fps and it is set
to loop, the image will reload 24 times a second, regardless whether anything else is
changing on the screen. Making your still flash pictures run at, for example, 1 fps and/or
switching off looping will ease the load on everyone’s browser. Very slow animation, for
example tweened over 40 or so frames and looping, will cause the least strain and can
create some very effective movement.

Once again, this manual does not pretend to provide a comprehensive Flash tutorial.
Please look on the web for more detailed information on using Flash.

4.5 Backdrops
As long as the original image is 380x240pp or larger, a backdrop will fill the UpStage
screen, including going behind the text chat window. The text chat window has a white
background in order to ensure that text is always readable, even over busy backdrops, but
this means that the area at the right of your backdrop will not be visible. You may wish to
create a backdrop that has a blank area on the right where the text chat window will cover
it to ensure that important parts of your backdrop are not hidden behind the chat window.

The proportions of the whole image are:

total width : total height - 10 : 6.2

width of stage area : width of chat area - 7 : 3

minimum width : height – 380 : 240 pixels

This diagram illustrates the proportions of the stage and chat areas (bear in mind that
everyone’s screen size and browser window size can be different – your backdrop will
stretch to fill the space):
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Note that in the Player view of the stage, an strip along the bottom of the backdrop will
be obscured by the Backdrop and Prop Image Galleries – but as these tools are not seen
by the audience, it is recommended that your backdrop extend below that strip.

Backdrops can be created as .png, .swf, .gif or .jpeg; as with avatars and props, .png or
.swf will give the best quality results. Note that .png files should NOT be interlaced when
saving. If you are using .gif or .jpeg, upload a test backdrop to see if it’s going to be good
enough, and remember to delete unwanted images.

When creating a series of backdrops for a particular show, it’s a good idea to give them
filenames that begin with the show name, so that when it comes to assigning them to the
stage, they are displayed together in the list. This applies to props and avatars as well.

4.6 File Sizes
There is currently no limit to the size of graphics files that can be uploaded to UpStage,
however this doesn’t mean you shouldn’t try to keep your files small. The larger your
original files, and the more graphics assigned to your stage, the slower the stage will load.
Performance after loading may also be affected, especially for anyone on dial-up.

What is a “reasonable” file size for your original graphic? This is very hard to say, as it’s
completely different for a small static flat graphic prop which may be only 1K, and an
animated flash backdrop or multiframe avatar, which could be over 500K. And a stage
with a single large graphic may load faster than one with many medium sized graphics.

If your original files are larger than 500K, check whether you can resize them and save
them again to a smaller file size. Remember that screen resolution is only 72dpi so there
is no need for your originals to be at a higher resolution.
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4.7 Deleting Graphics
It is important to delete unwanted graphics in order to keep the workshop area
manageable. This is done through the “Manage avatars”, “Manage props” and “Manage
backdrops” screens. Check the box beside any images that you want to delete then scroll
up or down and click the “delete selected” button.

You can see on these screens whether an image is currently assigned to a stage; if you try
to delete an image that is assigned to a stage, UpStage will ask if you are sure that you
want to delete it. If multiple groups are using the same server you should not delete
anything unless you are sure no-one else is using it (for example your own test graphics
that you no longer want).

4.8 On-stage Links
Hyperlinks from the text chat are coming very soon; but sometimes it’s useful to have a
graphic on-stage that provides a hyperlink to another stage or a different web site. The
way to do this is to create a .swf image with an ActionScript button containing the
following code:

on (release) {
getURL("http://desired.url", "_self");

}

This could be an avatar or a prop that is placed on the stage at the time that you want the
audience to follow the link.
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5 Technical
Upstage is written in Python, using the Twisted framework for event-driven
asynchronous networking (twistedmatrix.com). It doesn't require Apache (or MYSQL or
anything else). The client is written in pure Actionscript, and is compiled using Mtasc
(http://www.mtasc.org/), so there is no requirement for Macromedia software other than
the Flash player plug-in on the client computer. We are investigating Gnash, an open
source equivalent to the Flash player, to see if UpStage is compatible with it.

Words typed in by the players are converted into speech using the Fesitval speech library
(festvox.org/festival), eSpeak (http://espeak.sourceforge.net/) and MBROLA
(http://tcts.fpms.ac.be/synthesis/mbrola.html), and streamed to the clients as MP3s.

The server runs on Debian Linux, but should easily convert to other platforms. Python
and Twisted are cross-platform, but there is a line or two of shell scripts that tie in the
speech synthesis.

The software has been worked on since June 2003 and contains some 8000 lines.

5.1 Client Hardware & Software Requirements

5.1.1 Hardware
If your computer has a browser with the Flash player plug-in, then you already have
everything you need. Obviously faster processors and higher RAM give improved
performance, but UpStage has been designed to work on relatively low-spec client
machines.

A broadband internet connection will give the best performance, but UpStage performs
quite well over dial-up. The main disadvantage when using dial-up is that the load time
for each stage is much longer. You may need to allow up to 15 minutes to load a stage,
depending on how many graphics are on it. Once it’s loaded, the real-time interaction and
overall performance of UpStage is not dramatically worse on dial-up than on broadband.

5.1.2 Software
UpStage has been designed to run on a wide range of clients using the Macromedia Flash
Player plug-in (version 7 or above).

Linux users may need to install gsfonts and gsfonts-x11 (see Section 5.6.4)
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5.2 Firewalls
UpStage will function through most but not all firewalls, depending on how the firewall
has been set up.

If you install your own UpStage server, it will ask you to specify which ports you want to
use (the defaults are 8081 and 7230). You will need to ensure that your users have the
correct ports open.

The Open UpStage server (http://upstage.org.nz:8084) uses ports 8084 and 7233  –
therefore these ports need to be open if you are trying to access this server through a
firewall. These ports are open by default in most private internet connections, but some
organisational networks will close any “unnecessary” ports.

5.3 Downloading and Installing the Server Software
UpStage is an opensource project, registered with SourceForge and licenced under the
Creative Commons Attribution-NonCommercial-ShareAlike 2.5 License and Gnu Public
Licence (GPL).

To download the latest version, go to: https://sourceforge.net/projects/upstage/

You will need to install additional packages, including  python, twisted, festival, festvox
voices, netpbm, gif2png, timeout, lame, swftools, rsynth and mbrola.  Some of these are
not availavle as official Debian packages. Please read the INSTALL file for more
information; and join the developers’ list if you wish to communicate with other UpStage
users on technical matters: http://lists.sourceforge.net/lists/listinfo/upstage-list

Upstage runs as its own web server, which runs by default on ports 8081 (you will be
asked to chose a port when you install it). If you have Apache on your machine, you can
use ProxyPassReverse or mod_rewrite to treat it as a vitrual host. Otherwise you can map
port 80 to 8081 with iptables or similar, or just include :8081 in the urls.

Upstage should be run as an unprivileged user.

Please note that technical documentation of UpStage is ongoing. If you are installing
UpStage yourself you may wish to comment on and contribute to this – please join the
email list for UpStage developers: http://lists.sourceforge.net/lists/listinfo/upstage-list

5.3.1 Customising UpStage
Once you have installed UpStage on your own server, you can customise it to suit your
own projects.
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The Foyer and Workshop screens can be easily customised by editing the HTML code.
You can add your own titles, images and logos, change colours and create links from the
Foyer to specific stages at performance times.

To modify the client itself, you need an actionscript compiler – the one we are currently
using is Mtasc (http://www.mtasc.org/) – note that you do NOT need this for the standard
installation and use of UpStage.

5.4 Web cams
Players wanting to use live video in UpStage will need to have a web cam and a separate
application that allows the player to FTP their video to the server as motion JPEGs.

5.4.1 Recommended Web Cam FTP Software
FTP freeware or shareware is available for the major operating systems. Theoretically
any web cam FTP application should work, however the following software has been
researched and tested during the development of UpStage. Please note that this is by no
means all the available software, and as time passes there will be more and better options.

The main features that we have looked for in web cam FTP applications are:
 ease of use;
 free or cheap, with no advertising on the image;
 the ability to resize the web cam image to custom sizes;
 any special effects features are a bonus.

5.4.2 Recommended Software for Windows Operating Systems

Fwink
At the time of writing, we are testing Fwink (version 0.9.95 beta) on Windows. It’s free,
has no ads and allows customised sizing.

“Fwink is a free and open source web cam application for Windows. It takes still images
from your camera at timed intervals and puts them on your web site with FTP. You can
add effects like text messages, time stamps and an overlay image.”

http://lundie.ca/fwink/
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5.4.3 Recommended Software for Macintosh

Oculus
Oculus (version 3.1X at the time of writing) works on both Mac OSX and OS9 and
earlier;  it’s free to try, cheap to buy, and has some pretty nifty features. The free trial
period is unlimited, and registering unlocks further features.

“Oculus is a Webcam software that has been enhanced to include motion detection, time-
lapsed movie creation, and remote image and movie cycling. It has flexible captioning
options, including an unlimited amount of translucent text and pictures. It has options to
transmit an image to a remote FTP site or to save a file locally if you have a Web server
running on your video capture machine. You also can add captions.”

http://www.intlweb.com

5.4.4 Recommended Software for Linux

WebcamD
“WebcamD can :

 Take pics every X seconds
 Add date & hour on pictures, with or without border
 Make HTML page for it
 Stop camera, putting an offline webpage
 To take a pics when you want if the daemon is running
 Upload pics by ftp on a remote server or create local file if a local web server is

running
 Customise HTML templates easily
 Configure the programme easily with a small and simple configuration file”

http://webcamd.tuxfamily.org/index_en.html

5.4.5 Web Cam FTP Configuration
Once you have chosen and installed the appropriate web cam software, you will need to
configure it to send the web cam images to your UpStage server. Following are the
settings you will need:

Host: URL of your UpStage server
username: (set by your UpStage administrator)
password: (set by your UpStage administrator)
filepath: filename.jpg
Port 21 (or other, set by your UpStage administrator)
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Before you begin to upload your web cam image to UpStage, check the pixel size,
bearing in mind that images increase in size when they are uploaded as avatars to
UpStage. If it is 160 x 120 or larger, it will take up half the stage or more and affect the
speed and performance of UpStage for everyone. We strongly recommend using a web
cam FTP application that allows you to scale your image to any size.

You will need to set a trigger that tells the application how often to take a new image; we
recommend 2-3 seconds, as any faster is likely to be faster than the image can travel from
your computer to the server and out to the other players and audience.

Once you have configured your web cam and are sending a live stream to your UpStage
server, you should be able to find the filename of your web cam stream in the list of
available video streams in the "Add a new avatar" section of the workshop. You can then
create an avatar using that stream, and assign it to a stage in the "Manage stages" section.
Use it on the stage as you would a normal avatar.

5.5 Speech
UpStage’s speech is generated by the Festival Speech Synthesiser, developed at the
Centre for Speech Technology Research at Edinburgh University
(http://www.cstr.ed.ac.uk/projects/festival/).

An avatar's voice is selected from a dropdown menu when adding a new avatar and
changed in the "Manage avatars" section (see section 3.2.3). There are currently about
100 voices on the UpStage server (http://upstage.org.nz:8084); if you are setting up your
own UpStage server, please see the technical documentation regarding installing voices.

You can install additional speech plug-ins on your own server to extend the range of
voices available to the avatars. As long as you don't mind messing around with the
sourcecode a little bit it's not difficult – Patricia Jung explains how she did it (for Linux,
using UpStage V1):

Just add another entry in the VOICES section in Upstage/upstage/voices.py like:

 #txt2pho/mbrola:
 'de1': ("| /usr/local/mbrola/pipefilt | /usr/local/mbrola/preproc
/usr/local/mbrola/Hadifix.abk /usr/local/mbrola/Rules.lst |
/usr/local/mbrola/txt2pho -p /usr/local/mbrola/data/ |/usr/local/mbrola/mbrola
/usr/local/mbrola/de1/de1 - -",
                      _fest),

I know, it looks awful but this is only because the command is an awful chain
consisting of four commands with a couple of options each and the relevant
path:
           "| pipefilt ...| preproc ... | txt2pho ... | mbrola ..."
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It does some preprocessing (like exchanging all appearances of "z.B." with
"zum Beispiel"), then hands the resulting text over to txt2pho and to mbrola.

As long as your command or command chain takes text input from the standard
input and outputs the result as sound in raw format on the standard output chain
(Unix stuff, ask me if you haven't heard about it) you can put whatever you like
in between the "| and the ".

The above mentioned awful command chain will work when one has installed
the txt2pho frontend; it uses the de1 female mbrola voice, and you can choose it
in the web interface using the name de1.

The only problem with this kind of reconfiguration is: As config.py isn't a nice
configuration file but a python script one needs to know at least that python is
very picky about vertical alignment: It's extremely important that your new
voice entries have the same amount of whitespaces at the beginning of the line
as the other voice entries.

The reason it took me so long was TTS: I failed completely and utterly in
making the German festival extensions for use with mbrola voices:

http://www.ims.uni-stuttgart.de/phonetik/synthesis/festival_opensource.html

work. Then I tried txt2pho with mbrola:

http://www.ikp.uni-
bonn.de/dt/forsch/phonetik/hadifix/HADIFIXforMBROLA.html

(http://bogmog.sourceforge.net/document_show.php3?doc_id=34 has a nice
installation description), ignoring festival, and this worked at once.
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5.6 Troubleshooting

5.6.1 Browser Problems
We are constantly monitoring browser compatibility, so if you experience problems
connected to your choice of browser, please email info@upstage.org.nz.

If you are having browser problems, we recommend the following:
 ensure that you have at least version 7 of the Flash player installed;
 close the browser window, open a new window and log in again. If you still have

problems after doing this, quit the browser application and restart it.

5.6.2 Stage Won’t Load
If the stage fails to load properly, and the splash screen remains over the stage with the
message “Couldn’t load all images”, this could mean that there is a corrupted image
assigned to the stage.

The first thing to do is try reloading, as it could just have been a blip in the data flow;
either use the “reload” button on the splash screen, or use the back button in your browser
to return to where you can from and click on the link to the stage again.

If this doesn’t work, you may need to remove a rogue image from the stage. If you had
just assigned a new image to the stage before you encountered this problem, then it’s
likely to be that one that’s causing the problem. Try unassigning that image from the
stage, and see if it will load.

If you don’t know which image it is, you may need to take everything off the stage and
reassign them one by one or alternatively, delete the stage and make a new one.

5.6.3 Fonts look bad
If an .swf file has been saved as low quality (in the original file), it can force the whole
stage to appear “low quality”. This can be changed by right-clicking (on a Mac,
control+click) on the stage, and selecting “Quality” from the menu that appears. If Low is
selected, change it to High and you will see that the fonts now display properly.

However, this will only correct the problem on your machine; your audience may not
know how to change the quality. A better solution is to work out which image is causing
the problem, delete it and resave the original file as high quality.
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5.6.4 Linux Fonts
If you are using UpStage on Linux you may find that fonts are not appearing on stage.
This problem is fixed by installing additional packages:

 apt-get install gsfonts gsfonts-x11
 and

http://www.macromedia.com/shockwave/download/download.cgi?P1_Prod_Versi
on=ShockwaveFlash&P2_Platform=Linux&P3_Browser_Version=Netscape4
untar/gzip

 close all browsers, run the installer (see installation instructions on the url above)

5.6.5 Other problems
Please email info@upstage.org.nz if you have any other problems and we will endeavour
to answer your questions and solve any bugs.


